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Triagem Touch SGA

OBJETIVO

Esta instrucao de trabalho tem por objetivo orientar na correta instalacao do software SGA Touch
em equipamentos que possuem tela touch para que os préprios municipes ou servidores
responsaveis pela triagem retirem as senhas para aguardar atendimento nas unidades da
Prefeitura de Sorocaba - SP.

REFERENCIAS CRUZADAS

Procedimentos

ATENDIMENTO AO USUARIO HELPDESK - SUPORTE

Instrucoes de trabalho

ATENDIMENTO REMOTO - SUPORTE

Definicoes

SGA - Sistema de Gerenciamento de Atendimentos: E um sistema de c4digo aberto e licenca
livre utilizado pela Prefeitura de Sorocaba - SP para gerenciamento de filas em unidades que tem
um grande volume de atendimento ao publico como a Casa do Cidadao, assim automatizando e
facilitando organizacao das filas de acordo com as necessidades da unidade.

INSTRUCAO

A instalacdo do servidor responsdavel por gerenciar o controle de atendimentos fica a cargo da
secao de sistemas, cabendo a secdo de suporte técnico a instalacao dos equipamentos e o
software para atendimento automatizado por telas touch, computadores ou notebooks.


https://consultic.sorocaba.sp.gov.br/uploads/images/gallery/2023-05/image.png
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Instalacao
Acesse a pasta compartilhada "\\pms-insup03\Programas\SGA\Triagem Touch (Totem)".
Para acessar:

Windows 10: Cliqgue em iniciar — Sistema do Windows — Executar, ou a combinacao de teclas
WINKEY + R.

Windows 7 ou anterior: Clique em iniciar - Executar, ou a combinacao de teclas WIMKEY + R.

3 Executar >

— Digite o nome de um programa, pasta, documento ou
' recurse da Internet e o Windows o abrira para vocé,

Abrir: Spms-insupl3\Programas\5GA\ Tnagem Touch (Totem] R

QK Cancelar Procurar...

Figura 1 - Janela "Executar"

Execute o arquivo "Triagem Touch Setup 2.1.0.exe", ele iniciard a instalacao e adicionard um
atalho na area de trabalho.

Copie o novo atalho para a area de trabalho publica.

A area de trabalho publica localiza-se geralmente em "C:\Users\Public\Desktop", podendo
haver alguma variacao.

Execute o programa "Triagem Touch".

Triagem
Touch

Figura 3 - Atalho "Triagem Touch" e seu respectivo icone
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Triagem Touch

View Window Help

“efRA  SETTINGS
SGA

4 PANEL SETTINGS
< Back
Locale Columns
GENERAL
English o 2 o U Group by departments
Server
Services Printer Wait time
Microsoft Print to PDF v 10s v
Cores
Fundo da pagina Fonte da pagina Fundo do topo Fonte do topo
#FFFFFF #000000 #4FC08D #FFFFFF

Fundo do rodapé Fonte do rodapé Fundo do botdo Fonte do botdo

Figura 4 - Janela "Triagem Touch" (Clique na figura para ampliar)

e No campo "Locale", modifique para Portugués;

e Em "Printer" selecione a impressora que ira imprimir a senha, a impresso ja deve ter sido
previamente instalada;

e Cligue em "Save" para salvar as configuracoes.

Triagem Touch - o X
View Window Help

v

Success

Configuration Ok

Figura 5 - Caixa de didlogo informando que as configuracdes foram salvas com sucesso

Cligue em OK, em seguida clique no menu View -> Reload para que as configuracdes entrem em
vigor, se o idioma continuar em inglés clique no menu View -> Force Reload.

Configurando o Servidor

No menu esquerdo selecione "Servidor".
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Trizgem Touch - %
View Window Help

J‘\‘SGA CONFIGURACOES

‘4 CONFIGURAGOES DA TRIAGEM

< Voltar Servidor

GERAL https://sga-prefeito.sorocaba.sp.gov.br/

Interface L.
Usuario

|
L ]

Servigos

...........
Client ID

Client Secret

---------------

Salvar
Figura 6 - Janela "Triagem Touch" configurando o servidor

Na pasta compartilhada (\\pms-insup03\Programas\SGA\Triagem Touch (Totem)\) contem o arquivo
de configuracao, basta copiar as configuracdes para o "Triagem Touch".

Lembrando que Public ID = Client ID

Clique em Salvar.
Em seguida clique em voltar no menu esquerdo.

Aguarde alguns instantes, se por um acaso o programa ficar congelado, cligue em View -> Force
Reload.

Triagem Touch

View Window Help

Escolha o servigo desejado

01-SEURB 02-SECID
03-SES 04-SEGOV/Concilia

Figura 7 - Menu para a tela Touch
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Para deixar o menu em tela inteira clique no menu View - Toggle Full Screem ou utilize a tecla F11
do teclado.

Basta testar a emissao das senha, se forem emitidas a instalacdo estd concluida com sucesso.



Instalar coletor AUDESP

OBJETIVO

Orientar a todos os servidores da Prefeitura de Sorocaba em como instalar o aplicativo "Coletor
AUDESP" do Tribunal de contas do Estado de Sao Paulo.

REFERENCIAS CRUZADAS

Procedimentos

ATENDIMENTO AO USUARIO HELPDESK - SUPORTE

Instrucoes de trabalho
ATENDIMENTO REMOTO - SUPORTE

Definicoes

AUDESP - Projeto de Auditoria Eletronica de Orgaos Publicos: Iniciativa do Tribunal de
Contas do Estado de Sao Paulo para o aperfeicoamento do controle de gestao governamental que
objetiva, através do concurso da tecnologia da informacdo, aprimorar os procedimentos de coleta
de dados e informacdes dos érgaos fiscalizados.

INSTRUCAO

O aplicativo "Coletor AUDESP" tem como requisito a maquina virtual Java na versao 8.

Para verificar qual a versao da maquina virtual Java instalada abra o Painel de Controle e encontre
o icone "Java", caso os itens estejam organizados por categorias, basta alterar em "Exibir por " no
canto superior direito.
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Todos os ltens do Painel de Controle

™ » Painel de Controle * Todos os Itens do Painel de Controle

Ajuste as configuragdes do computador

IEx\h\r por  lcones grandes ¥ I

Adobe Gamma (32 bits) 3& Ba(?kup e Restauragdo Barra dej’arefas e BPE Administrator (32
(Windows 7) mmm Navegagao bits)
Borland Database Help (32 gy, Central de Facilidade de Kl Central de Rede e

Arquivos

P

[

Gerenciador de

Central de Sincronizagio

=

D bits) & Acesso =~ Compartilhamento

L Bioniiundi TOSTIRRE Sl
% Dispositivos e Impressoras @ Email (32 bits) E¥ isrls:;;:esnifnemo T:I ;me:;i?vas

Gerenciador de

Fontes Gerenciador de audio HD .. 8 . L
A Credenciais "‘ Dispositivos
o "I Gerenciamento de Cores Graficos HD Intel ® ) Histarico de Arquivos &, | Java
Kyocera TWAIN (32 bits) «» Mouse Opcgdes da Internet \@ Opcgoes de Energia
Opgoes de Indexagio E1 Opgdes do Bxplorador de Pastas de Trabalho f:jf' Programas e Recursos
)

A=

Programas Padrio

Reconhecimento de Fala

P,

Recuperacao

Regido

Figura 1 - Janela "Painel de Controle"

Na janela "Painel de Controle Java" na aba geral clique em sobre para verificar a versao.

|£| Painel de Controle Java *

Sobre

Java Seguranga Avangado

Exibe as Informagdes de Vers3o sobre o Painel de Controle Java.

As definigiies de rede s3o usadas durante conexdes com a Internet. Por padrdo, o Java usara as
definigiies de rede do seu Web browser. Somente usugrios avancados devem modificar essas
definicies.

Definicées de Rede

Sobre o Java

arquivos o

. E, (build 1.8.0_371-b11)

O Javana| Copyrig ht (c) 2023, Oracle gfou suas empresas sfilizdas, Todos os dirsitos
reservedos,

Consulte a
Para obter mais informagSes scbre a tecnclogiz Java e explorar excelentes

aplicativos Java, vists hitp:fiw

ORACLE

| QK || Cancelar | Aplicar

Figura 2 - Janela "Painel de Controle Java" (clique na imagem para ampliar)

Instalando o Coletor
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A partir deste ponto peca ao usudrio que faca login no computador com seu
usuario e senha de rede e efetue o resto do procedimento com o aplicativo de
assisténcia remota do windows.

O coletor esta disponivel no endereco: https://www.tce.sp.gov.br/audesp/coletor, neste portal
também tem instrucdes de como instalar e utilizar o coletor. Nesta pagina procure pelo botao
"Launch" clique e aguarde o download do software.

> Comunicador - PMS. X | @ Editando a Pagina Instalar colete. X @ Coletor Audesp integrado a0 Por X + v = X

& c (ﬂ tcesp.gov.br/audesp/coletor G = ﬂ') * 0O a2

& AGEMDASERVIGCS (@ SwaggerUl @B Audesp FaseV (Terc.. ) AUDESP - Repasses..

[ acessizioace oon @O O QO o -

INSTITUCIONAL ~  SERVIGOS ™ LEGISLAGAO E JURISPRUDENCIA~  ESCOLA DECONTAS™  TRANSPARENCIA ™  FALE CONOSCO ™

W LOOIZ0S 08 MUNICIPIOS € ENTaaaes No AUGeSp (atuanzaao em 157/0272023) 18215 KB

Ambiente Produgao - Fases 1,2,3 e 4

Clique no botdo abaixo para a instalacdo do coletor das fases 3 e 4 do Audesp.

Versao tnica indicada para qualquer tamanho de arquivo:

TR

Ambiente Piloto - Fase 3 (Atos de Pessoal) e Fase 4 (Licitagoes e Contratos)

Clique no botdo abaixo para a instalacdo do coletor para uso somente no ambiente Piloto das fases 3 e 4 do Audesp.

Versao tnica indicada para qualquer tamanho de arquivo:

Utilizamos cookies essenciais e tecnologias semelhantes de acordo com a nossa palitica de privacidade e, ao continuar navegando, vocé
concorda com estas condicdes.

Prosseguir

Figura 3 - Pagina do tribunal de contas para download do coletor AUDESP

Ao terminar execute o arquivo "coletor.jnlp", caso abra uma caixa de didlogo perguntando com
qual programa deseja abrir o arquivo, escolha "Java Web Start Louncher".

Copie o arguivo "coletor.jnlp" para a darea de trabalho do usuario e oriente o usuario a
executar este arquivo caso o atalho do coletor AUDESP nao seja exibido.


https://www.tce.sp.gov.br/audesp/coletor
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Deseja executar esta aplicacio?

nome: Coletor Audesp

Editor: SAD PAULO TRIBUMAL DE CONTAS DO ESTADO

Locak hitps:/faudesp.tce.sp.gov.br

Esta aplicagdo sera executada com acesso irrestrito, o que pode colocar suas
informactes pessoais e as do computador em risco, Execute-a somente se confiar
no editor e no local adma.

6 Mais Informacdes Executar ] [ Cancelar

Figura 4 - Caixa de didlogo "Deseja executar esta aplicacao?"

Marque a caixa de selecao "Nao mostrar novamente..." e cligue em executar.

# Prestacdo Oficial para o TCE-5P - m} x

Pacotes Configuragies Ajuda

Tribunal de Contas
de Exlade de Soe Paulo

__"‘j_ TCESP AUDESP

Figura 5 - Janela "Prestacao Oficial para o TCE - SP"

Assim estd concluida a instalacdo do coletor AUDESP.

Erro Conhecido

Caso apresente um erro conforme a figura abaixo, trata-se de uma excecao relacionada a paginas
consideradas inseguras pelo Java.
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[ Mais InformagGes b

Erro: java.lang.ExceptionInInitigizerEnror: null

java.lang ExceptionInInitializerEmror

at com.sun.depioy, net, protocol https. Handler .openConnection{Unknown Source)

at java.net.URL. openConnection{Unknown Source)

at com.sun.deploy, net, BasicHttpRequest, createlUriConnection{Linknown Source)

&t com. sun.deploy . net. BasicHitpReguest. dofequest{Unknovwn Source)

at com.sun.deploy.net, BasidHttpRequest. doHeadRequestEX {Uinknown Source)

at com.sun.deploy. cache . ResourceProvides Impl . che dkUpdate Avalable (Unknown So
urce)

at com.sun.deploy, cache . ResourceProvider Impl.isUpdateAvaiable (Unknown Source

at com.sun.deploy, cache . ResourceProviderImpl . getResource (Unknown Source)
at com.sun.deploy. cache . ResourceProvider Impl. getResource (Unknown Source)
at com. sun.javaws. Launcher, updateFinalLaunchDesc{Unknown Source)
at com. sun. javaws . Launcher . prepareTolLaunch(Unknown Source)
at com.sun.javaws. Launcher, prepareTolLaunch(Unknown Source)
at com.sun.javaws.Launcher . laundch{Unknown Source)
at com.sun. javaws, Main. laundh App{Unknown Source)
at com.sun.javaws Main. continuelnSecureThread(Uinknown Source)
at com. sun. javaws. Main. access S000({Unknown Source)
&t com.sun.javaws. Mains 1Lrun{Unknown Source)
at java.lang. Thread.run{Unknown Source)
Caused by: java.lang. SecurityException: No TLS/S5L protocol i enabled.
at com,sun.deploy . net, protocol https Handler SInitializer , <dinit=(Unknown Source)
.. 18 more

Figura 6 - Janela "Mais Informagodes”

Basta adicionar o endereco https://audesp.tce.sp.gov.br nas excecdes do Java.

Na janela "Painel de controle Java", na aba "Seguranca clique em editar lista de sites" e adicione o
endereco nas excecoes.
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| £ Painel de Controle Java — b

Geral Java Avancado

Ativar Conteddo Java para aplicativos de browser e Web Start

0 nivel de sequranca dos aplicativos ndo esta na lista de Excecies de Sites

() Muito Alta

Somente aplicativos Java identificadas por um certificado de uma autoridade confiavel
poderdo ser executadas, e somente se o certificado puder ser verificado como ndo
revogado,

@ Al

Os aplicativos Java identificados por um certificado de uma autoridade confidvel poderdo ser
executadas, mesmo que o status de revogacdo do certificado ndo possa ser verificado.

Lista de Excectes de Sites

0Os aplicativos adonados pelos sites listados abaixo terdo permissdo para serem executadas apos
os prompts de seguranga apropriados.

https:/faudesp. tce.sp.gov.br ~
v I Editar Lista de Sites... il
Restaurar Prompts de Seguranca Gerendiar Certificados...
0K Cancelar Aplicar

Figura 7 - Janela "Painel de Controle Java"
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FIGMA

OBJETIVO

Figma é um editor grafico de vetor e prototipagem de projetos de design baseado principalmente
no navegador web, com ferramentas offline adicionais para aplicacdes desktop para GNU/Linux,

macOS e Windows. Wikipédia

REFERENCIA CRUZADA [OPCIONAL]

[REFERENCIAS A OUTROS CONTEUDOS DO CONSULTIC]

Procedimentos

[LINKS INTERNOS DE PROCEDIMENTOS RELEVANTES A ESTA INSTRUCAOQ]

Instrucoes de trabalho

[LINKS INTERNOS DE INSTRUCOES DE TRABALHO RELEVANTES A ESTA INSTRUCAO]

Definicoes [OPCIONAL]
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[DEFINICOES DE TERMOS RELACIONADOS]

[TERMO] - [DEFINICAO]

INSTRUCAO

Erros conhecidos

Figma nao carrega arquivo e acusa erro no 'WebGL'

e Contexto:
o Computador 'HolyDragon'

(e]

Placa de video Intel UHD 730
e Confirmacado de Erro: Abra o Figma, Plugins > Development > Open Console, o erro sera
"WebGL: CONTEXT_LOST WEBGL: loseContext: context lost"
e Solucao: No atalho do Figma: Botao direito > 'Propriedades", em "Destino" inserir " --
disable-gpu-compositing" ao final.

Fonte: https://forum.figma.com/t/figma-glitches-on-intel-uhd-730-webgl-context-lost-

error/5195

inagengnd oRiguraXXn- Legenda da figura

[FINALIZAR COM BREVE CONCLUSAO]
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OCS Inventory

OBJETIVO:

O objetivo deste documento é fornecer um guia claro e objetivo para a instalacao do agente OCS
Inventory, considerando as particularidades e requisitos especificos de cada sistema operacional -
Windows e Linux.

O OCS Inventory devera ser instalado em todos os computadores que derem entrada no laboratério
e nos computadores que tiverem seus sistemas operacionais reinstalados.

CONSIDERACOES:

1. Ainstalacdo do agente via antivirus nao é periddica, é executada somente sob demanda e
nao contempla computadores com Linux.

2. Ainstalacdo do agente via GPO no momento nao é possivel tecnicamente, temos outras
demandas que gostariamos de atender via GPO que também nao puderam ser
implementadas.

3. Ainstalacao do agente nao pode ser replicada por imagem de disco.

INSTRUCAO:

WINDOWS:

Copie o arquivo "windows_agent.exe" localizado em "\\pms-insup03\suporte\Agentes OCS
Inventory\Instaladores\Windows\" para a area de trabalho.

Execute o arquivo "windows_agent.exe" e siga 0 passo-a-passo abaixo:



Agent 2.10.1.0 Setup

Setup will quide you through the installation of OCS
Inventory M Agent 2.10.1.0,

It is recommended that you close all other applications
before starting Setup. This will make it possible ko update
relevant system Files without having to rebook your
compuker,

Click. Mext to conkinue.

l Mext = ] Cancel
\ . Pressione "Next"

<+ OCS Inventory NG Agent 2.10.1.0 Setup

‘_Il_: : ‘G\ Licenze Agreement

Plzase review the license terms before installing OCS Inventory

inuen tory MG Agent 2.10.1.0.

Press Page Down ko see the rest of the agreement,

M
[
S Invenkaory MG Licence I

5 Inventary MG software is released under the GMU GPL version 2 license
rsee below),

Howewer, this product is also subaordinate ko the License Agreements of the
software components included in OCS Invenkory MG Agent For Windows,
Zlib, Dpenssl, cURL, Tiny=ML and ZipArchive.

If vwou accept the terms of the agreement, click I Agree to continue, You must accept the
agreement ko insktall OCS Inventory MG Agenk 2,10,1.0,

< Back l I Agree Cancel
" . Pressione "I Agree"
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Iinvento ry want ta inskall,

Check the components you want to install and uncheck the components you don't want ko
install, Click Mext bo continue,

Select the type of install; Metwork inventory -
Or, select the optional Working data folder
%C;Tgiﬁnents vou wish to Upgrade from 1. Agent

' 0CS Inventary Agent

Mebwork imventory (server reachable)
[] Local inventory {no netwark, connection)
Uninstaller

Description
Space required: 18,4 MB

< Back Cancel

L 4 Pressione "Next"

< OCS Inventory NG Agent 2.10.1.0 Setup

1] . | — r_a_- OCS Inventory NG Server properties
" Fill in OiCS Inventary MG Server address and ophions. ..

nventory

Server URL { htkp[s]:ffyour_ocs_server[iocs_server_port]: focsinyventary

Server credentials (optional). ..

User :

Passward :

Server secutity (DISABLIMNG THIS IS MOT RECOMMEMDELD). .

[ | validate certificates {specify path to file cacert. pem below)

i Certificate path  cacert.pem

< Back Cancel

& 4+ Pressione "Next"
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IMVENory

Prowy bype ¢ Mone e

Address

Park

Proxy credentials {optional). ..

User :
Passward
< Back Cancel
4 4 Pressione "Next"
. OCS Inventory NG Agent 2.10.1.0 Setup — *

‘ ]l . : t_:;_- OCS Inventory NG Agent for Windows properties
d b ) )

- If needed, specify OCS Inventory NG Agent options...

inventory

General options. ..
[ |Enable verbose log
[ ] Do not scan for installed Software
[ I Mever ask for TAG

Specfy TAG value :

Setup options. ..
[ ] Do not register service - agent must be launched manually (= NO_SERVICE)
| B Co not register Systray applet to automatically start (= NO_SYSTRAY)

B Immediately launch inventory (= MNOwW)

< Back Cancel

Pressione "Next"
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mventory o -

WHMI options. ..
Behavior aof WM calls :  COMPLETE e

COMPLETE: Allow 'WMI ko retrieve current domain user
READ: Mok allow

If the WMI does nok allow the recovery of the current user
which default user should OCS return

Default user domain @ |

< Back Cancel

= Pressione "Next"

¢ OCS Inventory NG Agent 2.10.1.0 Setup

| ll_: ; r-S- Choose Install Location

Chonose the Folder in which ko inskall OCS Invenkory MG Agent

inventory :uumn.

Setup will install ©OCS Inventary MG Agent 2.10.1.0in the Fallowing Folder, To inskall in a
different Folder, click Browse and select another Folder. Click Install bo start the installation.

Destination Folder

Z:\Priogran Files S Invenkory &genk) Browse, .,

Space required: 15.4 MB
Sparce available: 239,9 GB

< Back Inskall Cancel

L = Pressione "Install"

Neste ponto a instalacdo comecard, aguarde o processo ser concluido e siga para o préximo
passo
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= e

QS Inventory MG Agent 2,10.1.0 has been installed on
your computer,

Click Finish to close Setup,

B start OCS inventory NG Syskray Applet

| Enmsh |
L = Pressione "Finish"

Apds estes passos a instalacao no Windows estara concluida.

LINUX

Copie o script "linux_agent.sh" localizado em "\\pms-insup03\suporte\Agentes OCS
Inventory\Instaladores\Linux" para a area de trabalho e siga as instrucdes abaixo:

Dar permissao para o script ser executado:

Open

Open With Other Application
Run as a program

Cut

Copy

Rename...
Mowve to Trash

Send to...
Compress 1 file

Mew Folder with 1 item
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linux_agent.sh Properties

Permissions

Open With

Owner Me

Access Read and write -
Group dgti -

Access None -
Others

Access None -

Execute Allow executing file as program

Security context unknown

Abra o Terminal e execute conforme o print:

dgtipdgti-virtual-machine:~$ sudo su

[sudo] password for dgti:

root@dgti-virtual-machine: /home/dgti# cd Desktop
root@dgti-virtual-machine: /home/dgti/Desktop# ./1linux_agent.sh

Aguarde a execucao do script e a seguinte mensagem no Terminal:

Copying SNMP MIBs XML files...

Activating modules if needed...

Launching OCS Inventory NG Unix Unified agent...

No snaps are installed yet. Try 'snap install hello-world'.
Unknown device "/dev/hwmonl": No such file or directory

-> Success!
New settings written! Thank you for using OCS Inventory l
root@dgti-virtual-machine:/home/dgti/Desktop# ||

Processo finalizado:

Reset table columns
3how 10 w | entries

O Computer : IMEVDEVICEID Computer Computer : Domain Computer : Userdomain Computer : Operating system
O pms-310707-2024-12-27-16-56-49 pms-310707 prefeitura.local Zorin 0S 17
O pms-351461-2025-03-10-15-06-53 pms-351461 prefeitura.local Zorin 08 17
O dgti-virtual-machine-2025-04-01-14-11-18 dgti-virtual-machine localdomain Zorin 08 17

<
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